
11 класс 

Проект к главе 2 «Обработка звука»  

Теоретический минимум 
Как известно из курса физики, звук – это воспринимаемые человеком колебания 

среды (воздуха или воды). Параметр, который фиксируется человеческим ухом, это 
давление среды.  

Как и любая волна, звук характеризуется двумя основными параметрами – 
амплитудой (т.е. величиной колебания) и частотой (т.е. количеством колебаний за 
единицу времени). Эти параметры в физических звуковых волнах постоянно изменяются, 
воспринимая их, мы слышим звук. 

Поскольку в природе звуковая волна непрерывна, то для обработки звука с 
помощью компьютера необходимо построить модель его оцифровки – т.е. 
преобразования в числовое (двоичное) представление и обратное преобразование – для 
воспроизведения. Цифровое представление дискретно, поэтому процесс иногда называют 
дискретизацией. 

Рис. 1. Оцифровка звука 

Для выполнения оцифровки звука, 
колебания давления среды с помощью микрофона 
переводится в электрические колебания. 
Оцифровка звука выполняется как составление 
таблицы замеров возникающего напряжения. 
Замеры выполняются через определенные равные 
промежутки времени. Для того, чтобы 
охарактеризовать этот промежуток, указывают 
частоту дискретизации – т.е. количество замеров 
за одну секунду. Точность оцифровки напрямую 
зависит от частоты – чем чаще замеры, тем точнее может быть передано колебание звука 
при воспроизведении. Если частота дискретизации ниже частоты самого звука, то 
изменения начинают теряться (из-за усреднения значений). 

Второй параметр, от которого зависит точность воспроизведения это количество 
возможных градаций напряжения. Это количество градация зависит от количества битов, 
отведенных на запись значения, т.е. разрешения (обычно 24 бита).  

При профессиональном обсуждении каждое измерение давления будет называться 
отсчетом. Чем выше частота отсчетов и чем больше глубина кодирования, тем 
естественнее и качественнее будет компьютерный звук. 



рис.2

 

 

Как и в случае с графическими данными, представление звука в виде потока 
замеров порождает большой объем данных, затрудняющий и хранение и передачу звука. 

При прямой записи, объем получающихся данных достаточно велик. Например, 
при записи 16-битного звука с частотой 22КГц 1 минута звучания займет в памяти 60 
секунд * 22000 значений * 2 байта = 2578Кб 128 байт 

Объем данных для приведенного рисунка Вы можете подсчитать сами. 

Для решения проблем, связанных с большим объемом,  при работе со звуком часто 
используют методы сжатия с потерями, использующими особенности восприятия звука 
человеком, которые изучаются специальной научной дисциплиной – психоакустикой. 

Особенную популярность при упаковке звука завоевал стандарт сжатия MPEG-1 
Layer 3 (сокращенно называется MP31), разработанный Институтом Фраунхоффера. При 
сжатии этим методом используется сжатие с потерей информации. При этом,  
учитывается особенность слухового восприятия: если рядом расположены две частоты, то 
более громкая «перекрывает» более тихую. Таким образом, ее можно сгладить без 
ощутимой потери качества звука. Для реализации этого эффекта весь поток разделяется на 
равные небольшие фрагменты, в которых и выполняется удаление незаметных 
человеческим ухом звуков. 

Формат MP3 позволяет хранить моно или стерео звук, и таким образом для 
высококачественного кино-звука не очень подходит. 

1 Существуют и MPEG2 Layer 3, и MPEG2.5 Layer 3 
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Основным параметром, определяющим качество звучания, для формата mp3 будет 
битрейт (Bit Rate – битовая скорость), то есть количество битов в закодированном 
потоке в секунду. Считается, что человеческое ухо не различает изменения в звуке при 
битрейте 128 КБит/сек, но на практике это зависит и от средств кодирования (MP3 – не 
точный алгоритм, а формат хранения), и от средств воспроизведения. Формат MP3 
позволяет работать с битрейтами до 320Кбит/сек, причем битрейт может быть как 
постоянным для всего потока, так и переменным. 

На практике даже опытный эксперт часто не фиксирует разницы при битрейте 256 
Кбит/сек. 

Кроме сжатых звуковых данных, формат MP3 позволяет хранить и информацию о 
звуковом фрагменте – название, автора и т.п. с помощью т.н. тегов. 

Помимо обработки звука как последовательности замеров давления, очень часто 
компьютер используется как средство создания мелодии, моделируя звучание разных 
инструментов. 

Мелодия синтезируется как проигрывание нот каким-либо инструментом, который 
ее должен исполнять. Поскольку сложные мелодии исполняются согласованно 
несколькими инструментами (говорят - голосами), то современные программы такого 
рода обеспечивают работу с несколькими голосами. 

Ноты в данном случае выступают как основные, несущие звуки. Частоты нот (в 
герцах) известны: 

 

Частота, 
Гц 

Суб-
контp- Контp- Большая Малая 1.00 2.00 3.00 4.00 5.00 

Hота октава октава октава октава октава октава октава октава октава 

До  32.70 65.41 130.82 261.63 523.25 1046.50 2093.00 4186.00 

До-диез  34.65 69.30 138.59 277.18 554.36 1108.70 2217.40 4434.80 

Ре  36.95 73.91 147.83 293.66 587.32 1174.60 2349.20 4698.40 

Ре-диез  38.88 77.78 155.56 311.13 622.26 1244.50 2489.00 4978.00 

Ми 20.61 41.21 82.41 164.81 329.63 659.26 1318.50 2637.00 5274.00 

Фа 21.82 43.65 87.31 174.62 349.23 698.46 1396.90 2793.80  

Фа-диез 23.12 46.25 92.50 185.00 369.99 739.98 1480.00 2960.00  

Соль 24.50 49.00 98.00 196.00 392.00 784.00 1568.00 3136.00  



Соль-диез 25.95 51.90 103.80 207.00 415.30 830.60 1661.20 3332.40  

Ля 27.50 55.00 110.00 220.00 440.00 880.00 1720.00 3440.00  

Си-бемоль 29.13 58.26 116.54 233.08 466.16 932.32 1864.60 3729.20  

Си 30.87 61.74 123.48 246.96 493.88 987.75 1975.50 3951.00  

 

Если точно воспроизвести ноты по этим частотам без добавлений, то мелодия 
будет похожа на мелодию флейты. 

Для синтеза звука с другими инструментами применяются средства, получившие 
названия аппаратных и программных секвенсоров (синтезаторов). Такое средство 
синтезирует звук на основе указания тона (ноты), времени ее звучания и образца звучания 
того или иного инструмента. Образец звучания называется сэмплом. 

 

 

Рис.3. Подготовка музыки в программе Guitar Pro 

 

Для обеспечения качественного звучания большого количества разнообразных 
инструментов разрабатываются специальные библиотеки сэмплов. Современные звуковые 
карты обладают собственной памятью, позволяющей загружать такие библиотеки от 
сторонних разработчиков и процессорами, выполняющими синтез звука. 

При хранении и обмене синтезируемая мелодия описывается стандартизированным 
набором команд, получившим название MIDI (Musical Instrument Digital Interface). 
Стандарт включает в себя протоколы взаимодействия аппаратных средств (например, 
звуковой карты и отдельного устройства-синтезатора), и описание формата хранения 
файлов. 



Для ввода мелодии в стандарте MIDI в компьютер применяется специальное 
средство ввода – MIDI клавиатура. Фактически, она похожа на клавиатуру пианино, но 
предназначена для передачи соответствующих нот звуковой карте – для последующего 
синтеза звука заданным инструментом. Программы синтеза мелодий отображают 
набранные ноты в соответствии с музыкальной нотацией и позволяют редактировать их. 

В этом практикуме мы будем говорить прежде всего об обработке музыкальных 
файлов, представленных в виде оцифрованного звука, поскольку подготовка MIDI-записи 
требует наличия музыкального образования и уверенного владения нотной записью. 

Практикум по обработке звука состоит из 10 заданий- этапов, пройдя которые мы 
получим готовую к тиражированию музыкальную композицию. Само собой, чтобы 
выполнить эту часть работы звукорежисера требуется записанный звук, который вы 
можете найти на диске. 

 



Практикум 

Задание 1. Основы звукорежиссуры 
На сегодняшний день компьютер с соответствующим программным обеспечением 

позволяет знающему человеку делать со звуком самые невероятные вещи.  

Программ обработки звука огромное количество. Некоторые из них позволяют 
изменить скорость воспроизведения звукового файла, другие изменить тональность 
записанной музыки и многое-многое другое. Программы, позволяющие выполнить 
большинство операций с музыкальными файлами (фактически – последовательностями 
звуков) называются музыкальными секвенсорами и предназначены для 
профессиональной звукорежиссерской работы.   

К таким программам относятся Adobe Audition, Fruity Loops Studio, Cubase, Nuendo и 
многие другие. Более простые для освоения и работы, на взгляд авторов, продукты 
компании Steinberg – Cubase и Nuendo. Обе эти программы имеют схожий интерфейс и 
незначительные отличия. В этом практикуме мы будем осуществлять обработку звука в 
программе Nuendo 3.  

По типу использования Nuendo относится к условно бесплатному типу программного 
обеспечения. Программой можно бесплатно пользоваться в течение нескольких сот 
рабочих часов. Этого хватит для выполнения заданий практикума. Скачать пробную 
версию можно бесплатно с сайта разработчика  (www.steinberg.net). 

Процесс обработки записанной музыки в виде отдельных файлов (дорожек или 
треков), каждый из которых может содержать записанные либо партии музыкального 
инструмента, либо вокала, либо просто некоторые звуки, принято делить на три части: 

1. Трекинг (Tracking) – процесс редактирования записанных звуковых файлов, с 
помощью стандартных инструментов секвенсора (обрезка, склейка и прочее).  

2. Сведение (Mixing) – этап создания единого звукового трека, на котором основная 
цель звукорежиссера – добиться, чтобы каждая из записанных дорожек была 
отчетливо слышна в общем звучании всех треков.  

3. Мастеринг (Mastering) – финальный этап работы со сведенной звуковой 
дорожкой. На этом этапе основной задачей звукорежиссера является добиться 
максимально качественного звучания в рамках стиля музыкального трека, а также 
устранить оставшиеся недостатки звука в целом. 

 

Задание 2. Интерфейс программы Nuendo 
Как уже говорилось, программа Nuendo является многофункциональным 

музыкальным секвенсором. Мы изучим лишь основные ее возможности. 

2.1. Запустите программу. 

2.2. При первом запуске программа предложит протестировать имеющееся звуковое 
оборудование – согласитесь. 



2.3. Откроется окно программы: 

  
 
2.4. Изучите элементы меню программы, которые нам понадобятся: 

2.5.  

 

 

 

  

 

 

 

 

 

2.5. Проверьте, какой звуковой драйвер выбран в настройках программы. Если выбран 
один из стандартных драйверов производителя секвенсора – поменяйте его на 
драйвер свой звуковой карты. Если этого не сделать программа, возможно, будет 
работать не корректно. Выбирая драйвер карты, вы сообщите программе обработки 
целый ряд параметров которые обычно не учитывают - поскольку обработкой звука 
как таковой не занимаются.. 

 Выбор драйвера своей звуковой карты: 

основные операции 
открыть, сохранить 

проект и прочее 

основные операции 
по редактированию 

дорожек 

настройки текущего 
проекта (качество 

записи, темп и 
прочее) 

отображает папку, в 
которой хранятся 

аудио-файлы проекта 

устройства 
(настройки звуковой 

карты и прочих 
устройств) 



 Меню → Devices → Device Setup 

 

  

 

Если у вас возникают трудности с выбором драйвера – скачайте из интернета и 
установите драйвер ASIO4ALL. Этот драйвер универсален и должен работать со всеми 
звуковыми картами.

1.  Выбираем аудио 
устройства 

2.  Выбираем 
драйвер своей 
звуковой карты 

3.  OK 



 

Задание 3. Создание и настройка проекта 
 Для того чтобы начать обработку треков, требуется создать проект с 
определенными настройками и разместить треки в проекте. 

3.1. Создайте новый проект: 

 Меню → File → New Project  

 

  

 

3.2. Здесь нам предлагается выбрать ранее сохраненные настройки проекта. Поскольку 
мы создаем проект впервые – выбираем Empty (пустой). 

3.3. Перед нами дерево каталогов нашего компьютера, где мы должны выбрать папку, в 
которой будет храниться наш проект. Чтобы не превращать все в свалку, лучше 
всего для проектов создать отдельную папку и помещать все папки с дальнейшими 
проектами туда. Итак, создайте такую папку, назовем ее, к примеру, Projects, в ней 
создайте папку First Project. Выбираем эту папку и нажимаем OK. В папке First 
Project у нас автоматически будет создана папка Audio, в этой папке будут 
храниться все звуковые файлы проекта.  

3.4. Перед нами появится окно проекта. Ниже представлен снимок проекта с уже 
загруженными аудио дорожками.  

Изучите основные области окна проекта:



 

 

  

 

 

 

 

 

 

3.5. Откройте окно настроек проекта:  

 Меню → Project → Project Setup 

3.6. Настройте параметры проекта: 

 Sample Rate – 44.100 kHz (частота отсчетов в секунду при кодировании звука). 

 Record format – 24 Bit (глубина кодирования – количество бит для кодирования 
каждого отсчета) 

 Record File Type – Wave (разрешение/тип аудио-файлов проекта) 

 Указанные настройки являются оптимальными, и большинство используют именно 
их. Можно указать настройки и выше, но изменения в качестве вряд ли будут 
различимы, зато размер звукового файла значительно увеличится.  

область выбора активной 
дорожки и ее основных 

настроек 

дорожка – 
звуковой 

файл 

рабочая 
область 

область всех 
настроек 

выбранной дорожки 

панель 
инструментов 



3.7. Сохраните ваш проект.  

Меню → File → Save As 

Укажите имя файла, например, Tracking and Mixing. После сохранения в папке 
проекта появится файл проекта, с которым мы можем продолжить работу в любое 
время. 

Задание 4. Добавление аудио в проект 
4.1. Сейчас в нашем проекте нет ни одного звукового файла. Добавим их: 

 Pool → Open Pool Window 

Правой кнопкой мыши нажимаем на иконке Audio → Import Medium.  

4.2.Через проводник найдите в папке практикума «Обработка звука» папку «Instruments», 
в ней лежат записанные партии инструментов к песне, с которой с которой мы будем 
работать. 

 

 

Выделить все 
файлы 

Открыть 



 

4.3. В появившемся окне импорта отметьте указанные пункты: 

 

 

Нам нужно выбрать первый пункт – скопировать файлы в папку проекта, если 
этого не сделать – никакие дальнейшие операции с файлами кроме прослушивания 
выполнять будет нельзя.  

Второй пункт предлагает при копировании в папку проекта конвертировать 
копируемые файлы в файлы с расширением проекта и его параметрами, чтобы с 
ними можно было работать. Этот пункт мы можем не выбирать т.к. все эти файлы 
уже в формате Wave и имеют те же параметры, что и наш проект.  

Разделение многоканальных (стерео и пр.) файлов нам тоже не нужно. Пока мы 
будем работать только с моно-дорожками. 

Нажимаем ОК. 

В результате, мы загрузили в проект все необходимые партии - то есть дорожки, из 
которых он будет состоять. 

4.4. Разместим загруженные дорожки в проекте.  

Закройте Pool Window и нажмите правой кнопкой на пока еще пустую область всех 
дорожек (см. рисунок выше).  

Появится список всех типов треков, которые мы можем создать. Нам нужно 
добавить аудио трек – нажимаем Add Audio Track.  

 

 



 

Появилось окно выбора конфигурации трека (сколько каналов будет в треке) – 
выбираем Mono.  

4.5.Вместо названия Audio 01 напишите более понятное название появившегося трека – 
Clean Guitar 1: 

 

  

 

4.6.  Дальше поместим соответствующий звуковой файл из Pool Window, в рабочую 
область на эту дорожку: 

Открываем Pool Window, перетаскиваем мышкой файл Clean Guitar 1на рабочую 
область соответствующей дорожки. Должно получиться так: 

 

 

 

Сверху над изображением звукового файла у нас идут цифры 1, 2, .. – это такты 
сетки метронома проекта. При работе с музыкой удобнее всего работать именно с 
ней. Если ее нет – ее можно настроить в Project Setup (настройках проекта). 

4.6.Поставьте курсор проигрывания перед дорожкой:  

 



 

 

Для этого кликните на поле сетки метронома в нижней его части: 

 

 

 

 

Нажмите клавишу пробел для воспроизведения дорожки с места, где установлен 
курсор.  

4.8.  Теперь добавим еще один файл в поле проекта, чтобы можно было одновременно 
слушать две гитары: 

Создайте еще одну звуковую дорожку, как мы это только что сделали и добавьте в 
нее файл Clean Guitar 2. Должно получиться примерно так: 

 

 

 

Воспроизведите. Две гитары звучат одновременно. Правда, мы их еще не 
выровняли, поэтому они могут немного «не попадать» друг в друга. 

Установить курсор 



4.9.Чтобы не выравнивать дорожки в ручную в Nuendo есть возможность притягивать их 
общей сетке метронома. Именно так на записи добиваются идеального попадания 
музыкантов в ритм. Чтобы это можно было сделать установите следующие настройки 
на панели инструментов: 

 

 

 

 

 

 Длительности нот: 

   1/1 

   1/2 

 

   1/4 

  

 

Если какого-то элемента нет на панели инструментов, то можно нажать на ней 
правой кнопкой мыши и отметить галочкой необходимый инструмент: 

притяжение к сетке использовать притяжение  

к нотам, какой длительности  



 

 

4.10.  После включения притяжения к сетке, выбрав на панели инструмент 

«Перемещение»  можно двигать дорожки четко по четвертым нотам сетки. 
Сделайте так, чтобы файлы начинались воспроизводиться точно в одном месте – с 
начала второго такта: 

  

 

 Воспроизведите – теперь гитары должны «попадать» друг в друга. 

4.11. Добавьте аналогичным образом остальные файлы из Pool Window в проект. 
Сделайте так, чтобы дорожки все начинали воспроизводиться с начала второго 
такта. Должно получиться так: 



  

 

4.12. Воспроизведите и послушайте результат.  

Задание 5. Трекинг 
5.1. Сейчас мы занимаемся первым этапом редактирования – трекингом. Здесь в задачу 

звукорежиссера входит сделать так, чтобы каждый трек звучал идеально для 
дальнейшего сведения. Послушаем отдельно дорожку с бас гитарой. Нажмем 
кнопку  (Solo) на дорожке Bass. 

5.2. Воспроизведите, послушайте. Слышите щелчки  при склейке кусков? Это 
абсолютно нормальное явление при склейке на записи. И это очень просто убрать с 
помощью Nuendo. 

5.3.  Щелчки находятся на сетке метронома. Так как в середине песни темп (скорость 
игры музыкантов) меняется нам нужно загрузить темпотрек (темп, 
отображающийся в виде общей сетки метронома) данный для этой песни: 

Меню → File → Import → Tempo Track 

Выбираем файл tempo_track в паке практикума. Теперь все места склейки 
находятся на линиях сетки метронома. 



 

 

5.4.Теперь слушаем, где щелчки у баса. Между 11 и 12 тактом есть щелчок. Выберете 

инструмент «Ножницы»  на панели инструментов и разрежьте файл между 11 и 12 
тактом (притяжение к сетке должно быть включено – иначе разрезать дорожку точно 

по сетке сложно). Выделите две полученные дорожки, инструментом  с зажатой 
клавишей Shift: 

 

  

 

5.5.  Сделайте склейку выделенных треков, начав клавишу X на клавиатуре: 

 Результат: 

    

 

 

    

Первый трек плавно 
убывает по громкости 

Второй трек плавно 
возрастает по громкости 



Воспроизведите. Щелчок должен убраться. Сделайте так с остальной частью 
басовой дорожки, где услышите щелчки (ищите на началах такта).  

Выполненная операция называется Crossfade – плавный  переход уровня сигнала.  

5.6.  Добавим в проект ударные инструменты. В Pool Window добавим для удобства 
отдельную папку барабанов в паке Audio. Правой кнопкой нажимаем на папке 
Audio → Create Folder. Появится новая папка – переименуйте ее в Drums 
(барабаны). Добавьте туда все файлы из папки Drums в папке практикума (правой 
кнопкой мышки в Pool Window на папке Drums, дальше аналогично).  

 

 

 

Должно получиться, как показано на рисунке. Справа всегда указывается 
информация о файлах. Заметьте, из новых файлов три имеют конфигурацию Stereo, 
такую конфигурацию нужно будет выбрать и у создаваемого трека для этого файла. 

Поместите партии ударных инструментов  в проекте, аналогично инструментам. 
Прировняйте все партии к началу второго такта: 



 

 

Задание 6. Сведение, панорамирование 
Итак, у нас теперь каждая партия находится в проекте, все дорожки выровнены и 

склеены. Теперь мы можем приступать к сведению. Для начала прослушаем еще раз то, 
что у нас уже есть без какой-либо обработки. Звучит не очень, правда? Громкости не 
настроены, что-то теряется, что-то слишком выбивается, все инструменты перекрывают 
друг друга. Ликвидировать все эти недоразумения и сделать общее звучание более 
выразительным мы можем на этапе сведения. Вот основные его шаги: 

1. Панорамирование 
2. Эквализация 
3. Компрессия 
4. Дополнительные эффекты 

Подробнее разберемся с каждым из них. 

Панорамирование – это первый этап сведения, на котором каждой дорожке 
выделяется отдельная область в пространстве.  

У нас две колонки и из них играет музыка, о каком пространстве идет речь? 

Все не так просто. Стерео-звучание, как вы, должно быть, знаете, не для того, чтобы 
звук из двух колонок был просто громче. Если вы, например, включите свою любимую 
группу на плеере и послушаете музыку через один наушник – вы все поймете.  



Дело в том, что при сведении музыки, например, одной гитаре выделяется полностью 
в правый канал (колонка, наушник), а другой полностью левый. Таким образом, создается 
имитация объема, с разных сторон которого звучат разные музыкальные инструменты 
(создается панорама). У слушателя возникает ощущение, что справа от него играет один 
инструмент, а слева другой. При этом инструменты, «разведенные» по панораме, уже не 
будут так перекрывать друг друга.  

В музыке часто можно услышать, как какой-то звук, как бы, перетекает из одного 
наушника в другой, это тоже достигается за счет панорамы. 



 

 

 

 

 

     

 

 

6.1.Итак, «разведем» гитары по панораме. Для этого откроем микшерный пульт (микшер) 
Nuendo: 

 

 Меню → Devices → Mixer (или клавиша F3)  

  

Результат 
панорамы 

Левый канал Правый канал 

Название соответствующей 
дорожки в проекте 

Регулятор громкости 
дорожки 

Регулятор панорамы 
дорожки 



Нажмите на микшере кнопку  (Solo) на дорожках Lead Guitar 1 и Lead Guitar 2, 
чтобы слышать только их. 

С помощью регуляторов панорамы поместите дорожку Lead Guitar 1 полностью в 
левый канал, а Lead Guitar 2 – полностью в правый канал.  Прослушайте результат. 
Улучшилось ли звучание? 

Заметьте, что дорожка может находиться не полностью в каком-то одном канале, а 
например, только на 80% в левом. Это значит, что 20% останутся в правом канале, 
и мы их будем немного слышать правым ухом. Таким образом, у нас возникнет 
ощущение, что звук играет не слева, а слева спереди. Это особенно заметно, если 
слушать музыку в наушниках. 

6.2. Аналогично «разведите» по панораме дорожки Clean Guitar 1 и Clean Guitar 2. 
Прослушайте результат. Общее звучание должно стать лучше, гитары не будут 
наслаиваться друг на друга.  

У остальных дорожек не меняйте панораму, все моно дорожки будут по умолчанию 
в центре панорамы, а стерео дорожки уже разведены по панораме (послушайте 
отдельно стерео дорожку OH). 

6.3. С помощью регуляторов громкости убавьте звук у дрожек гитар и баса, так чтобы 
они не заглушали барабаны, и мы могли по возможности слышать каждую 
дорожку. 

Задание 7. Сведение, эквализация 
Эквализация – это второй и один из самых важных этапов сведения. Что же такое 

эквализация? Слово кажется сложным, но на самом деле все элементарно.  

Звуки можно разделить на звуки низкие по частоте, средние и высокие. Например, бас 
гитара имеет низкое звучание – по большей части ее звук находится в низких частотах и 
занимает их почти целиком. Обычная гитара занимает большинство средних частот и 
часть высоких. «Железо» барабанов (тарелки) – большинство высоких.  

Однако бас гитара все равно немного звучит в области средних и в области высоких 
частот, тем самым перекрывая звучание обычных гитар и тарелок. Так и любой другой 
записанный инструмент все равно немного будет звучать вне своего основного частотного 
диапазона. 

Эквализация помогает убавить громкость ненужных частот у звука и поднять 
громкость тех частот, на которых инструмент будет хорошо звучать вместе с остальными. 
Попробуем это проделать. 

Подобная обработка ведется с помощью расширений программы - так называемых 
звуковых плагинов, которые реализует большинство эффектов при обработке. Наложим 
нужные эффекты на отдельные треки. 

7.1.  Откройте миксер. Добавьте расширенный миксер и добавьте в нем выберите 
Разрывы (поля для вставки звуковых плагинов) всем дорожкам: 



      

 

7.2. Вставьте эквалайзер в первый Разрыв трека Clean Guitar 1.  

 

 

 

 

 

7.3. Установите режим Solo только дорожке Clean Guitar 1, чтобы услышать, как 
эквалайзер меняет звук: 

  

  

 

1. Расширенный миксер 

2. Выбор поля 

3. Разрывы 

Нажимаем левой кнопкой мыши 

Вкл. 

Открыть 

Режим Solo 



7.4. Откройте и изучите окно эквалайзера: 

 Изучите, как настроить эквалайзер: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

  
Низкие Средние Высокие 

Настройки 
средних 
частот 

включены 

Частота 
152 Гц 

Поднялась 
на 2.7 дБ 

Насколько «узко» 
поднимается частота, 
захватывая соседние 

Плагин 
включен 

Звуковые 
частоты 

Уровень 
громкости 
частоты 

Низкие Средние Высокие 



 Поэкспериментируйте с ручками, чтобы лучше разобраться, как изменение их 
положения влияет на кривую эквалайзера и на звук дорожки. 

7.5. Частотный диапазон гитары обычно выше 150 Герц. Убавьте у дорожек Clean 
Guitar 1, Clean Guitar 2, Lead Guitar 1, Lead Guitar 2  низкие частоты: 

 

7.6. Сделайте эквализацию у других дорожек: 

1. Solo Guitar – убавить низкие частоты до 200 Hz и «узко» поднять 5000 Hz 
(5kHz) на 10 децебел (дБ). 

2. Bass Guitar – убавить низкие частоты до 50 Hz и «узко» поднять 150 Hz и 5kHz 
на 10 дБ, «узко» понизить 300 Hz на 10 дБ. 

3. KD – убавить низкие частоты до 60 Hz, «узко» поднять 80 Hz и 5kHz на 10 дБ. 
4. SD – убавить низкие частоты до 100 Hz, «узко» поднять 200 Hz и 5kHz на 10 

дБ. 
5. Toms – убавить низкие частоты до 100 Hz, «узко» поднять 200 Hz и 5kHz на 10 

дБ. 
6. OH – убавить низкие частоты до 550 Hz. 
7. Room – ничего не меняем. 

7.7. Настройки эквалайзера могут варьироваться на вкус звукорежиссера, т.к. каждый 
проект уникален, у разных инструментов немного различаются частотные 
диапазоны.  

 Определить точно в каком частотном диапазоне звучит конкретный инструмент, 
могут помочь более многофункциональные эквалайзеры, которые, при 
воспроизведении трека отображают уровень звучания инструмента на каждой 
частотной полосе. 



Воспроизведите то, что у нас получилось. Для сравнения можно на время 
отключить все эквалайзеры, которые мы загрузили, и послушать, какой звук был 
раньше. 

 При обработке звука очень полезно делать такие сравнения. Включите все 
эквалайзеры снова. Эквализация завершена. 

 

Задание 8. Сведение, компрессия 
Компрессия – это третий шаг в сведении композиции. Что такое компрессия?  

Сравните, например, дорожки Lead Guitar 1 и Bass: 

 

 

 

 

 

Дорожка Lead Guitar по рисунку уровня громкости ровная на протяжении всего трека. 
Дорожка Bass наоборот динамична на протяжении всего трека.  

Динамика в игре на музыкальном инструменте – естественное явление, так как 
музыкант не робот и не может играть все ноты с одинаковой громкостью. Однако в общем 
звучании такая динамика иногда очень сильно «режет слух». Поэтому мы ее уберем 
компрессором (плагином, который в заданной степени уменьшает громкость звуков, 
уровень громкости которых выше указанного порога). На рисунке представлен отрывок 
дорожки баса не компрессированный, компрессированный и обработанный лимитером 
(плагином выполняющим полное «выравнивание» всех нот по громкости):



 

 

  

  

 

8.1. Добавьте компрессор во второй разрыв дорожки Bass и изучите его окно: 

Звук без обработки 
(явные пики 
громкости) 

Компрессированный 
звук (менее явные 
пики громкости) 

Звук, обработанный 
лимитером 

(отсутствие 
пиков громкости) 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8.1. Настроим границу срабатывания Threshold, чтобы «сгладить» пики – то есть 
уменьшить их громкость на 10 дБ.  

 

 

 

Включите проигрывание дорожки баса. Меняйте границу срабатывания и следите 
на компрессоре за шкалой  Gain Reduction (сколько дБ «сглаживается»). Выберите 
такую границу, чтобы показатель «сглаживания» Gain Reduction колебался в 
области 10 дБ. 

 

Режим компрессор 

Режим пики 
громкости 

Сколько дБ 
«сглаживает» Граница 

срабатывания 
Степень 

компресси
 Скорость 

срабатывания Скорость 
выключения 

Количество дБ 
добавленных 

после обработки 

Граница 
срабатывания 



8.2. Установите максимальную степень компрессии. 

Установите минимальное значение скорости срабатывания (Attack)  и скорость 
выключения (Release) оставьте по умолчанию. 

8.3. Поднимите выровненный звук на 10 «сглаженных» дБ (Make Up Gain). 
Прослушайте результат. Отключите компресср сравните с предыдущим звучанием. 

8.4. Включите режим лимитер в окне плагина: 

Сделаем наш бас идеально ровным по громкости.  

Выставите границу срабатывания -12 дБ. Таким образом, 
лимитер будет «срезать» все звуки, уровень громкости 
которых выше -12 дБ. 

Послушайте результат. 

8.5.  Сделайте компрессию дорожек: 

1. KD – Алгоритм – Peak, Trashold – (- 32) дБ, Ratio: 8:1, Attack – 0.1, Release – 
Auto, Make Up Gain – 15 дб. 

2. SD – Алгоритм – Peak, Trashold – (- 40) дБ, Ratio: 8:1, Attack – 10, Release – 
Auto, Make Up Gain – 10 дб. 

3. Toms – Так же, как у дорожки SD. 

У компрессии много других применений, например можно сделать несколько 
компрессий и звук станет довольно специфичным. У каждого звукорежиссера есть 
свои секреты по использованию компрессоров 



 

Задание 9. Сведение, дополнительные эффекты 
Обычно трех перечисленных выше этапов профессиональному звукорежиссеру будет 

достаточно для того, чтобы свести трек на хорошем уровне. Но, как правило, появляется 
желание добавить еще что-нибудь. Здесь уже все зависит от фантазии и знаний 
звукорежиссера. Расскажем о двух часто применяемых эффектах. 

Мульти полосная компрессия. Вкраце, это компрессия определенных частотных 
диапазонов. Этот эффект может придать инструменту более яркое звучание. Сделаем это 
для гитар в нашем проекте. 

9.1. Откройте микшер и установите дорожкам Lead Guitar 1 и Lead Guitar 2 режим Solo.  

9.2. Во вторые разрывы треков Lead Guitar 1 и Lead Guitar 2 установите плагин: 

 

 

 

9.3. Послушайте результат. 
Выключите мульти полосную 
компрессию и сравните с тем, что 
было ранее. 

9.4. Сделайте мульти полосную компрессию для дорожек: Solo Guitar, Bass, KD, SD и 
Toms с соответствующими готовыми настройками: Electric Guitar, Electric Bass, 
Bass Drum, Snare Drum и Snare Drum. 

9.5. Послушайте результат. Выключите мульти полосную компрессию и сравните с тем, 
что было ранее. 

Выберите 
готовые 

настройки для 
гитары 



Реверберация. Реверберацией называют эффект, при котором звук прекращает свое 
звучание не сразу, а продолжает некоторое время отдаленно звучать в пространстве. 
Представьте, что вы находитесь в длинном коридоре с гладкими твердыми стенами. 
Издавая какие-либо звуки, вы можете слышать как, они распространяются вдаль по 
коридору, отражаясь от стен. Это и есть эффект реверберации. Применение его к 
некоторым трекам делает их звучание лучше. Этот эффект обычно не применяется к басу, 
и другим дорожкам, которые «поддерживают» ритм композиции. Обычно этот эффект 
применятся к вокалу, соло гитаре, к акустическим гитарам. В нашем проекте вокала нет, 
поэтому сделаем реверберацию на дорожках Clean Guitar 1 и Clean Guitar 2. 

9.6.  Во второй разрыв треков Clean Guitar 1 и Clean Guitar 2 поместите Реверб: 

  

8.7. Сделайте также реверберацию для дорожек: 

1. SD с готовыми настройками Medium (средняя комната),  
2. Solo Guitar с готовыми настройками Small (маленькая комната).

Готовые настройки 
«большая комната» 



 

Задание 10. Мастеринг 
Итак, осталась заключительная часть, придать звучание нашей 

композиции, соответствующе выбранному стилю и устранить общие 
оставшиеся дефекты. Делать это можно в этом же проекте, можно создать 
отдельный проект. Мы сделаем это в отдельном проекте.  

Первое что нужно сделать – это проверить, чтобы наш сведенный 
проект не зашкаливал по общей громкости, и как следствие этого не было 
искажений в звуке. Откройте микшер и посмотрите дорожку общего 
звучания (мастер шину). 

Если горит красная кнопка Clip, значит, наш проект зашкаливает по 
громкости и ее нужно уменьшить. Делается это на этой же дорожке 
регулятором громкости. Сделайте так, чтобы общая громкость была в 
районе -6 дБ. 

 

 

 

 

Сохраните файл, полученный после сведения.  

10.1. Для этого нам нужно выделить область проекта, которую мы хотим сохранить.  

Подведите курсор к верхней части поля сетки метронома, пока не появится значок 
в виде карандаша.  

Ставим курсор для выделения: 

  

Растягиваем слева направо область выделения на столько тактов сколько нам 
нужно (до конца песни): 

 

 

Выделенная область должна быть окрашена в синий цвет. Область, окрашенная в 
красный цвет, означает неправильное выделение (справа налево). 

Чтобы было удобнее растягивать, можно уменьшить масштаб ползунком внизу 
справа: 

 

Трек зашкаливает по 
громкости 



10.2. После того как мы выделили сохраняемую область. Можем сохранить сведенный 
файл.  

Меню → File → Export → Audio Mixdown 

Выбираем папку нашего проекта и сохраняем сведенный файл: 

 

  

 

 

 

10.3. Теперь приступаем к мастерингу. Создайте новый проект назовите его, например, 
Mastering. В нем создайте одну аудио дорожку с конфигурацией стерео. И через 
Pool Window импортируйте сведенный нами трек на эту дорожку. 

10.4. Откройте миксер и поместите на сведенную дорожку эквалайзер. Увеличьте звук в 
районе 5 кГц. Поэкспериментируйте с другими частотами. 

10.5. Посмотрите на рисунок дорожки в проекте. Снова видим динамику уровня 
громкости. Сделаем звук по громкости ровнее с помощью компрессии. Поместите 
компрессор после эквалайзера (порядок, кстати, имеет значение, именно в таком 
порядке будет происходить обработка звука).  

10.6. Настройте компрессор: Алгоритм – Peak, Trashold – (-22) дБ, Ratio: 4:1, Attack – 
0.1, Release –  Auto, Make Up Gain – 5 дБ. 

10.7. Добавьте мульти полосную компрессию. Сделайте настройки по вкусу. 

10.8. Отрегулируйте общую громкость проекта, так чтобы она не зашкаливала.  

10.9. Сохраните полученный звуковой файл с расширениями wave и mp3.  

Теперь можно закрыть Nuendo и насладиться своей работой, послушав файл на 
плеере. Сравните результат с исходной несведенной версией. 

Надеемся, что материалы этого практикума будут полезны для вас. Конечно, выполнив 
все задания, представленные в нем, вы не станете сразу же профессиональным 
звукорежиссером. Но предложенный практикум, по мнению авторов, может стать для вас 
первым шагом к достижению этой цели.  

Имя файла 

Тип\разрешение 
файла 

Тип 
кодирования 

Стерео Глубина 
кодирования 

Частота 
отсчетов 
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